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CP9844-L: Moldflow Synergy API Training

Part 1: An Introduction

David Astbury Senior Manager, Solver Development

Matt Jaworski Senior Moldflow Technical Specialist



In this class we will:

 Show how to build practical API scripts using the API in Moldflow Insight

 Introduce the API functionality and conventions 

 Automate MFR creation, create custom plots, interface result with other 

programs (Excel & PowerPoint)

 Present a mixture of lectures and hands-on exercises to ensure that we cover 

the theoretical and practical aspects of building API scripts 

Some programming knowledge is preferred, but not required

Class summary



At the end of this class, you will be able to:

 Leave with all the required knowledge to build usable API scripts using 

Autodesk Moldflow Synergy

 Understand the concepts, conventions and principles behind the API

 Show how to do common tasks with the API

 Show how the API can be used to export data

Key learning objectives



 Started developing  Moldflow Software in 1988

 B App. Sci. (Chemistry) University of Melbourne

 Roles: Developer, R&D Manager, QA Manager, Senior Manager

 Expertise:  Numerical Simulation, Optimization/Design of Experiment 

(DOE), Project Management, QA Management, Moldflow API, 

IT/Linux, Software Development, Automation

Biography – David Astbury



 Used Moldflow since 1996, joined Moldflow in 2000

 Roles: Support, Training, Application Engineer, Manager

 Erie Plastics, Hewlett Packard, Rubbermaid previously

 Taught at UMass Lowell & Penn State Erie

 Dual BS Degrees (Mechanical Engineering & Plastics Engineering 

Technology – Penn State University)

 MS Plastics Engineering from UMass Lowell

 Finishing PhD in Plastics Engineering from UMass Lowell

Biography – Matt Jaworski



 Dr. Franco Costa

 Dr. Nanda Santhanam

 Assisted in preparation of material

Caroline Dorin Hanno van Raalte

Shishir Ray

Assisting Today



 CP12451-L: The Autodesk Moldflow Synergy API part 

2: Building real world applications

 Monday 30th November 1:00 pm – 5:00 pm

 San Polo  3503, Level 3

 CP10731-L: Learn to Create Professional, Stunning 

Reports with MS Office and the Synergy API

 Tuesday 2nd December 1:00 pm – 2:15 pm

 San Polo  3503, Level 3

Related Sessions



House Keeping



Timetable



 Are you a Moldflow user?

 Do you have any programming experience?

 Are you taking this afternoon’s class?

 What do people want to achieve today?

Demographics



 Ask questions at any time

 We may refer it to a break if it’s complex/lengthy

 Have Fun

 This is Las Vegas after all

 After the class

 Feel free to contact us to discuss your requirements/projects

 A little advice/direction from us may save you a lot of time

Standing Orders



 Assist each other with the exercises

 Feel free to exchange code/ideas

 If you are stuck, look at the solution

 Complexity increases with each task in the exercises

 If you finish early

 Help others

 Experiment with what you have learned

 Compare your approach with others. Often there are many solutions.

 If your programming skills are poor then pair up with somebody 

who has done some programming before!

Exercise Standing Orders



API



 API = Application Programming Interface

 An Object Linking and Embedding (OLE) programming 

interface that allows AMI functionality to be automated

 Manipulation of AMI is done through scripts or third party 

software

 Functionality available since MPI 4.0 (2002)

 Additional functionality added in each major Insight release

What is the Autodesk Moldflow Insight API?



 Increase user productivity for repetitive tasks

 Customize the UI, result plots & solvers

 Support 3rd party add-on products

 Enhance integration to 

 ERP

 Enterprise-wide applications

 CAD/CAE

 MS Office Excel/Word/PPT

 Support university research programs

 Standardize corporate protocols and best practices

 Support industry data formats

Why use the AMI API?



Quick API Example Demonstration



 An OLE automation client is needed to control the API though 

AMI. Examples include:
 Visual Basic Script or vbScript (VBS)

 AMI records all scripts in Visual Basic Script

 Other Potential Interfaces 

 JScript and other programming languages

 Visual Basic for Applications (VBA)

 This is a fully featured client that is part of the Microsoft Office application suite

 Visual Basic (VB)

 Perl

 Python

 ActiveX scripts in Internet Explorer

 Autodesk only provides help/support for VBS

OLE Introduction



 The OLE automation interface will automatically use the 

version of Synergy (AMI’s GUI) that was most recently 

executed on your computer

 If you last opened an early version of AMI/MPI and try to run a 

macro or script that uses features that are not supported, your 

macro or script will generate an error

OLE Introduction



 Prior to  the 2016 Release it was only possible to run 1 

API instance across all Synergy Instances

 API now works with multiple Synergy instances

 You can launch a macro for a specific instance of Synergy 

on the local machine, using the InstanceID that you can find 

in the About box

Running multiple Synergy Instances  



 Edit Macros recorded/written prior to the 2016 

 Add the following code segment

Running multiple Synergy Instances



 Execute a script from the command line

 Available since the 2016 release

 Allows synergy.exe to be run from scripts or external processes

 The synergy UI window will always start

 No way to stop this

 Synergy will exit when the script completes

 Examples

synergy.exe /script c:\myscript.vbs

synergy.exe /silent /script c:\myscriptwitharguments.vbs 10 “fred”

Synergy Command Line



 Syntax
/script SCRIPT [ARGS] : Running script in Synergy's instance

/silent : Run the script without showing any VB errors or message boxes

/noshutdown : Do not shutdown Synergy after running the script

if /noshutdown is not sent, then Synergy will return an error code:

0 = no errors were reported

1 = could not execute script

2 = script may not support Per-Instance execution

any other = error returned by the script itself (by calling Wscript.Quit)

Synergy Command Line



 Valuable resource for the beginner or expert

 Accessed via
 Help > User’s Guide > Automation > Application Programming Interface 

(API)

 Help > Advice > Application Programming 

Interface (API) under the Help home page

API On-line Help



Example Help VB Scripts 



API Reference Manual



Class Member



 A TCode corresponds to a single feature in the process 

settings, geometry or solver parameters

 When programming with the Moldflow API, you need to 

know the numeric ID corresponding to a particular 

solver or modeling feature

TCode Reference





 A TCodeset comprises the TCodes which together 

control one aspect of a solver

 When programming with the Moldflow API, you need to 

know the numeric ID corresponding to a particular 

solver or modeling feature

TCodeset Reference





 Afternoon class will dive deeper into

 Class members

 TCodes

 TCodesets

 This class we will stick with the 

More to Come…



 Notepad++ Editor Only

 vbsedit Editor/Debugger

 Microsoft Visual Studio Editor/Debugger

Vbscript Editors/Debuggers Summary



Notepad ++

 Great tool for 

writing and editing 

scripts

 Really an editor 

only

 Free 



 Great tool for 

writing, debugging 

and editing scripts

 Free version 

available

 We will use this to 

run scripts using 

the Start icon

VbsEdit



 Online

 Include the word vbscript in any searches

 Searches often returns results for Visual Basic for 

Applications(VBA)
 VBA is compiled, vbscript is interpreted

 There are a number of user guides for vbscript
 Search for vbscript Language Reference or vbscript User Guide

 Books

VBScript in a Nutshell

vbScript Programming Resources



 Tools

 StudyMod – Modify an existing study File

 StudyRlt – Extract Result Data

 Key Features

 Provided on both Windows and Linux

 Command line driven

 Can be used within API scripts

 Typically used to interface with 3rd party optimization packages

API Related Utilities: StudyMod and StudyRlt



 StudyMod - Modify an existing Study file
 Allows changes to

 Boundary Conditions

 Mesh

 Processing Settings

 Materials

 Not designed to create/add/modify geometry

 Modifier file is in XML format

API Related Utilities: StudyMod



 Example Modifier File

Set the Melt Temperature to 240C

API Related Utilities: StudyMod



 StudyRlt – Extract Result Data

 Data which can be extracted

 Individual message output   (-message)

 Sequence screen output     (-exportoutput)

 Result in XML format (-xml)

 Model in Patran format        (-exportpatran)

 Value from Result Data (-result)

 By Region/Layer

 Calculation:  Min/Max/Average

API Related Utilities: StudyRlt



API Related Utilities: StudyRlt



Let’s Start Scripting…



1. Macros can be recorded and played from within the interface 

(Play Macro) or from the AMI command line

2. VB scripts can be run from the AMI command line with or 

without command line arguments, or they can be run from 

within AMI as macros

Two Ways to Automate AMI Using the API



 Macro recording and playback allows you to repeat user-

interface actions to automate common or repetitive tasks

 Macro recording and playback is built on top of the basic OLE 

automation interface

 Uses Visual Basic script as the recording and playback 

language

 By default, recorded macros are saved with a .vbs extension 

in the folder specified during installation:
 My Documents\My AMI 20xx Projects\scripts, 

(where xx is the software release number, i.e. 2016)

Macros



1. Select the Tools tab at the top of the Ribbon 

interface 

2. In the Automation panel, click Record Macro to 

start the macro recording

3. Perform a sequence of actions in the Autodesk 

Moldflow Insight Synergy interface

4. In the Automation panel, click Stop Recording to 

stop the macro recording

5. The Save Macro dialog appears, enter a name in 

the File Name box and click Save

Creating Macros (Recording)



1. Select the Tools tab at the top of the Ribbon interface

2. In the Automation panel, click Play Macro and the Open 

Macro dialog appears

3. Select a macro file of your choice and click Open. The 

macro plays

 Also the ability to assign macros to a GUI icon button

Macro Playback (In Synergy)



1. Locate the macro you want to run in Window Explorer

2. Double-click the required script.  The software will start if it is 

not currently running, and the script will open and run 

 Scripts that assume a particular study is already open, or that 

a particular result is already displayed, are not likely to work

 If your script uses parameters that are entered as command 

line arguments, you must run the script from the software 

command line

Macro Playback (Windows Explorer)



 State/Version Dependency
 Macros are recorded from a defined starting point

 Unless the starting point is always the same, behavior may be unpredictable

 Be careful when recorded macros use

 Selection Lists

 Results

 Path Names to Files Projects

 Not all events are recorded
 Some commands do not have API support (See Help for list)

 Mouse clicks associated with selection are not explicitly recorded

 The API records only the final entities selected

Issues with Macro Record/Playback



Exercise 1: Macro Recording 

Automating Communicator MFR File 

Creation 



1. Open EX1.mpi project

2. Open tutorial_model study

3. Start recording macro

4. Select the following results for Communicator mfr export
 Fill time, Temperature at flow front, Bulk temperature, Frozen layer 

fraction, Air traps, Average velocity, Pressure, Weld lines

5. Export and publish MFR to a location

6. Stop recording macro and save script as “mfr_export.vbs”

7. Open and review saved macro script in Notepad ++

8. Try to use the saved script on next study (results_study) 

9. Review MFR file in Communicator

Exercise 1 General Steps:





Issues? Questions?

Hint: Look in Solutions Folder



 The AMI command line allows you to invoke Visual Basic 

Scripts (VBS) and macros from a command line user interface 

within Synergy

 This allows you to run scripts that require you to provide 

parameters

 Note that this capability is dynamic and extensible.
 You can modify existing scripts to better suit your needs or extend them in 

order to add new capability

 You can add new scripts (containing multiple commands) that can be used 

just like the "built-in" commands that come with your AMI installation

AMI Command Line



 View tab > User Interface > Command Line to open the 

dialog

 Enter the name of the script without its file extension followed 

by any command line arguments the script requires

 Example: dr 25 25 30 rotates the model to these X, Y, Z angles in the 

Synergy graphics window

 Select Go or hit the Enter key and the script plays

Command Line



 Your default project folder specified during installation:
 My Documents\My AMI 20xx Projects\commands

(where xx is the software release)

 If AMI cannot find the script in the default project folder, it 

searches the AMI commands folder
 Typically, Program Files\Autodesk\Moldflow Insight 20xx\data\commands 

(where xx is the software release)

Command Scripts Locations



 Preloaded scripts available

 Type help in command line

 MFView/Modeler commands

Command Line



 If available, type help script_name (where script_name is 

the name of the script)

 Example: Type help DT into the command line text field and 

click Go
 Information about what function the script performs (DESCRIPTION) 

 Information about what you must type in on the command line to launch the 

script (SYNTAX) 

 Information about any parameter values that you need to type in on the 

command line when you run the script (PARAMETERS) 

 Any further information about the script (NOTES) 

Command Line Help for a Script



Command Line Help DT Example



 Scripts that do not have command line arguments (input on 

the AMI command line) can be run as macros

 If you need to create a script that uses parameters, you 

should write a script that takes command line arguments

 There are limitations to the API. For the latest list, look under 

Help > Application Programming Interface (API) > Limitations 

in API functionality

Additional Information about Scripts



 Allow user routines for selected properties and calculations
 Easier research collaborations

 User-coded routines in a DLL

 Example template provided

 First implementation users can supply their own function to calculate 

thermoplastic viscosity in 3D Flow analyses

 Others to follow:

 PVT ?

 Fiber Orientation ?

 Curing ?

Solver API – 3D Flow (mhb3d)



 This special API functionality is not covered in this class

 See examples in Help (Topic “Solver API Examples”)

Solver API – 3D Flow 



 Determine what you want the script to do

 Take advantage of macro recording to get the general 

guidelines for the script

 Edit the macro using an editor (e.g. notepad, notepad ++)

 Create additional objects and code as needed
 Use references such as API Reference as a guide

 Use code from other scripts, don’t reinvent the wheel

 Comments help others so add comments to your scripts

 Review examples in Help

 Test the script to remove any bugs

Programming Workflow



'%RunPerInstance

'@

'@ DESCRIPTION

'@ 

'@

'@ SYNTAX

'@ TheFirstLines

'@

'@ PARAMETERS

'@ none 

'@

'@ DEPENDENCIES/LIMITATIONS

'@ none

'@

'@ History

'@ Created MJJ 11/4/2015

'@@ 

Option Explicit

SetLocale("en-us")

Dim SynergyGetter

On Error Resume Next

Set SynergyGetter = GetObject(CreateObject("WScript.Shell").ExpandEnvironmentStrings("%SAInstance%"))

On Error GoTo 0

If (Not IsEmpty(SynergyGetter)) Then

Set Syn = SynergyGetter.GetSASynergy

Else

Set Syn = CreateObject("synergy.Synergy")

End If

'

' Put remainder of code here.

' 

MsgBox "Script Complete"

Wscript.Quit

Example API Script (First Lines)



Exercise 2: Custom Aspect Ratio



 Normally for MP or DD mesh

 Spikes or tensors

 What if we could display

this result differently?

 As contour plot of elements

 On 3D mesh

 Let’s try on this exercise

Aspect Ratio 



 Use EX2 files for this exercise

 Located in C:\AU2015\API Training 1\Exercises\Exercise 2 

Custom Results Aspect Ratio\EX2.mpi

 Open CustomAspect.vbs as a starting point in Notepad 

++

 Step 1: Use API help to find DiagnosisManager Class 

nomenclature and finish script

 Step 2: Use API help UserPlot Class to finish script

Workflow



Custom Aspect Ratio Contour Plot



Incomplete Script – Research to Finish Script



One Solution…



Exercise 3: Exporting to Excel



 Use EX3 files for this exercise
 Located in C:\AU2015\API Training 1\Exercises\Exercise 3 Exporting to 

Excel\EX3.mpi

 Open ExportAspectToExcel.vbs as a starting point in Notepad 

++

 Step 1: Use API help to find DiagnosisManager Class 

nomenclature and finish script. You can reuse your EX2 code

 Step 2: Review logic in how to export to Excel

 Run script to export results to Excel spreadsheet
 Try to export aspect ratio (elements), pressure (nodes), temperature at flow 

front (nodes), etc

Workflow



 Aspect ratio

 Element list

 Pressure

 Node list

 Temperature at flow front

 Node list

 See Solutions folder if 

stuck

Example Excel Export



Exercise 4: Exporting to PPT



 Use EX4 files for this exercise
 Located in C:\AU2015\API Training 1\Exercises\Exercise 4 Exporting to 

PPT\EX4.mpi

 Open ExportResultsToPPT.vbs in Notepad ++ and review 

script
 Introduce Sub & Call, Function for temp folder path

 Run script to export results to PPT 
 Fill time and Pressure 

 Try to export other plots

 See Solutions folder for other scripts for Histograms, multiple results on one 

page, etc

Workflow





 CountPPMaterialData.vbs

 DeleteAllResults.vbs

 ExportSpecifiedToMFR.vbs

 MaterialDataHistogram.vbs

 ReadShearRateProfileData.vbs

 ReadTemperatureProfileData.vbs

 ReadViscosityProfileData.vbs

 RunAllResults.vbs

 ShowMaterialID.vbs

 ShowMaterialTsetAndSubID.vbs

Useful Sample Scripts Folder Review





 Seek answers to all of your technical product questions by 

visiting the Answer Bar.

 Open daily 8am-6pm Tues-Wed and 8am-4pm Thurs

 Located just outside of Hall C on level 2.

 Staffed by Autodesk developers, QA, & support engineers 

ready to help you through your most challenging technical 

questions.

AU Answer Bar
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